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Preface

This guide describes the Cisco Unified Attendant Console Advanced client: a Windows application that 
works exclusively with Cisco Unified Communications Manager to provide telephone switchboard 
functionality on your computer. 

Cisco Unified Attendant Console Advanced enables you to answer calls from multiple queues and 
transfer them to extensions. It also enables you to park and retrieve calls, and create conference calls. 

Purpose of this Guide
This guide describes how to: 

• Configure Cisco Unified Attendant Console Advanced 

• Use Cisco Unified Attendant Console Advanced to make, answer, hold, retrieve, conference, and 
transfer calls 

Who Should Read this Guide
The document is intended for Cisco Unified Attendant Console Advanced users, and the staff who train 
them. 

Organization
This guide includes the following chapters:

Section Title Description

1 Getting Started This section explains the Cisco Unified Attendant Console 
Advanced interface, and how to start and log in to the 
application.

2 Customizing Cisco Unified 
Attendant Console 
Advanced

This section explains how to configure and customize the 
application. 

3 Using Cisco Unified 
Attendant Console 
Advanced

This section explains how to make, answer and clear calls, take 
notes, hold, and transfer calls.
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Conventions
This document uses the following conventions: 

Note Means reader take note.

Tip Means the following information will help you solve a problem. 

Caution Means reader be careful. In this situation, you might perform an action that could result in equipment 
damage or loss of data.

Timesaver Means the described action saves time. You can save time by performing the action described in the 
paragraph. 

Warning Means reader be warned. In this situation, you might perform an action that could result in bodily 
injury.

Convention Indication

bold font Commands and keywords and user-entered text appear in bold font.

italic font Document titles, new or emphasized terms, and arguments for which you supply 
values are in italic font.

[ ] Elements in square brackets are optional.

{x | y | z} Required alternative keywords are grouped in braces and separated by 
vertical bars.

[x | y | z] Optional alternative keywords are grouped in brackets and separated by 
vertical bars.

string A non-quoted set of characters. Do not use quotation marks around the string or 
the string will include the quotation marks.

courier font Terminal sessions and information the system displays appear in courier font.

<   > Non-printing characters such as passwords are in angle brackets.

[ ] Default responses to system prompts are in square brackets.

!, # An exclamation point (!) or a pound sign (#) at the beginning of a line of code 
indicates a comment line.
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Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html.

Subscribe to the What’s New in Cisco Product Documentation as an RSS feed and set content to be 
delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco 
currently supports RSS Version 2.0. 

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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1
Getting Started

Cisco Unified Attendant Console Advanced must have the relevant telephony software and hardware 
installed and configured. For details see, Cisco Unified Attendant Console Advanced Administration 
and Installation Guide. Contact your system administrator to configure your system.

Accessibility for Users with Disabilities
Cisco Unified Attendant Console Advanced provides accessibility features that make it easier for blind 
and visually impaired users to use the application.

Cisco Unified Attendant Console Advanced provides the ability to customize the appearance of the 
application making it simpler for users with low vision to adjust the look of the console. This enables 
users to work in the manner that they find most comfortable. To access the console settings choose 
Options > Preferences or Options > Font Size from the menu bar. For more information, see Chapter 2, 
“Customizing Cisco Unified Attendant Console Advanced”. 

You control the Console with either mouse or keyboard. Many interface controls are icons, which display 
a tool tip when the mouse is hovered over them. 

You can also use Cisco Unified Attendant Console Advanced with a screen reader plug in called JAWS. 
The screen reader provides information about the status of the attendant console as well as reading the 
text in the attendant console interface.

Cisco Unified Attendant Console Advanced also comes with context-sensitive help. For help specific to 
a window or a area, simply press F1.

For more information on Cisco Accessibility Program please contact through the following link 
http://www.cisco.com/web/about/responsibility/accessibility/contact.html. 

Using the Keyboard 
Most of the operations can be performed through mouse clicks; however, you can also use the keyboard 
to perform call control operations. Table 1-1 Shows the function keys that can be used to operate Cisco 
Unified Attendant Console Advanced.

http://www.cisco.com/web/about/responsibility/accessibility/contact.html
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Key Descriptions
Table 1-1 Key Descriptions

Key Name Description

Up Arrow Move towards the start of a list. 

Down Arrow Move towards the end of a list. 

Left Arrow Scroll a list left or select the item to the left. 

Right Arrow Scroll a list right or select the item to the right.

Tab Move Left-to-Right and Top-to-Bottom through the parts of the Console. 

Shift-Tab Move Right-to-Left and Bottom-to-Top through the parts of the Console. 

F1 Display Help.

F2 Alternative Numbers, Busy Lamp Field (BLF) and Presence Status. 

BLF shows the status of other extensjons (busy, ringing, available). 

F3 Will bring the cursor to the first Search field in the Directory area. 

Shift-F3 Clear any search results that are displayed in the active directory. 

Note: You can also clear the search results by clicking . 

F4 Create a Personal Directory Group.

Shift-F4 Edit an existing Personal Directory Group.

F5 Calls In Progress area.

F6 Speed Dials area.

F7 Active Calls area.

F8 Queued Calls area (Incoming Calls).

F9 Queues area.

F10 Go Unavailable.

F12 Contact Details.

Backspace Clears digits when typing a contact number. 

Insert Camp on. Used to stack a call against a busy extension.

Delete Re-establish. Retry a call.

Page Down Hold/Retrieve. Any call that returns to the Calls In Progress area; for example, no reply 
or a parked call is retrieved in the same way.

Enter Connect/Clear. Either connects the call or clears the call down depending on the 
operating transaction in process. 

Plus (+) Answer Next/Toggle. Answers the next highest priority call or when offering a call will 
toggle between calling and called parties. If a queue has Forced Delivery set then the 
call will move to the Active Call area F7 without pressing Plus.

Minus (-) Cancel Consult. Having offered a call, if the called party refuses, the key will drop the 
called party and the calling party is in circuit.

Home Call Park. Press to park a call on a park extension number.

End Conference. Used to start the conference procedure and then add parties.
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Additional Functions
You can perform additional functions using the Ctrl key in combination with other keys. These are 
explained in Table 1-2. 

Menu key Display the context menu for the selected section of the Cisco Unified Attendant 
Console Advanced interface. Use Up Arrow or Down Arrow to highlight item and 
press Enter to select. 

Space Bar Delete the number whilst in the process of dialing out. 

Alt-<number> Display selected directory. <number> is a whole number in the range 1 to 10, which 
selects the corresponding tab.

Table 1-1 Key Descriptions

Key Name Description

Table 1-2 Ctrl Key Functions 

Key Combination Function 

Ctrl-F2 Display the Lateral Search (Cross tab) within the directories. This 
requires enabling in Preferences

Ctrl-F4 Delete a Personal Directory Group.

Ctrl-F5 Display My Camped on Calls

Ctrl-E Force the queues into Emergency Mode

Ctrl-I Display the Login dialog box.

Ctrl-M Send an email to an extension user not responding to a call

Ctrl-O Log the attendant console operator out of the system.

Ctrl-Q Mute a call when certain actions are taken. This is set up in preferences 
and the actions include Performing a Search, Pressing numeric keys to 
dial numbers or Changing or Selecting Directory screens.

Ctrl-R Reclaim a call. 

Ctrl-T Add a contact. 

Ctrl-Tab and Ctrl-Shift-Tab Select the next directory tab or the previous directory tab and display the 
contact details. 
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Logging In
You must log in to the application with your Login Name, Password and Extension number. Each user 
has a unique identity to log in to Cisco Unified Attendant Console Advanced. Logging on to Cisco 
Unified Attendant Console Advanced also logs you on to Cisco Unified Attendant Console Advanced 
Server. After logging on successfully you can process both internal and external calls.

To login to the Cisco Unified Attendant Console Advanced, perform the following steps:

Step 1 Press Ctrl-I or choose File > Login, this will open the Login window. 

Figure 1-1 shows the Login window. 

Figure 1-1 Login Window 

Step 2 Type Login Name and Password.

Step 3 Either, select Use existing device details to re-use the extension you used during your last session, or 
enter an Extension. 

If you select Use existing device details, when you log in the application will ignore any duplicates that 
may exist in Cisco Unified Communications Manager, and you will not be prompted with the dialog box 
in Figure 1-2 on page 1-5. If you want to use a different number, de-select Use existing device details, 
and enter an Extension. 

Step 4 Click Login.

Table 1-3 explains the fields displayed in the Login window. 

Table 1-3 Login Window Fields 

Field Example Description 

Login Name OPERATOR1 You must provide a login name here in order to log into the application.

Password *** The password is required for secure login.

Extension 1000 Enter the extension number you are using to handle calls.
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If you are logging in to a resilient Cisco Unified Attendant Console Advanced installation, which has a 
Publisher (primary) and Subscriber (secondary) server, the application connects to the server it was last 
connected to. If the default Publisher server fails, as soon as there are no active calls the application cuts 
over to the Subscriber server. If the application cannot connect to the Publisher server at login, you are 
informed that you are being logged in to the Subscriber server. If the application cannot connect to either 
server, a failure message appears. 

Note When you are logged in to the Subscriber server you cannot do the following: 

• Change the user preferences. 

• Create, update or delete directory contacts, including contacts in the Busy Lamp Field (BLF) or 
Personal Directory Groups, nor can you create, update or delete Personal Directory Groups. 

If the Publisher becomes available while you are logged in to the Subscriber, you are asked whether you 
want to log into the Publisher or to stay logged in on the Subscriber. If the Subscriber fails while you are 
logged in to it, and if the Publisher is available, you are prompted that you are being logged in to the 
Publisher. 

The Extension number that is entered during login must be the Primary Number for a device. It is 
possible that the same extension number might be configured as a primary number for another device on 
a different partition. In order to differentiate between the two devices configured on the same extension 
number, the MAC address can be used to identify each device. A MAC address is a unique identifier for 
each device.

During login, if the operator extension you entered exists in multiple partitions or is shared within the 
same partition in Cisco Unified Communications Manager, and you have not selected Use existing 
device details, the Duplicate Device window appears. You can select a MAC address and view the 
relevant details for the directory number and select the correct device as shown Figure 1-2. 

Figure 1-2 Duplicate Device Window with Information for the Selected Device
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When you select a MAC address, the following information for the selected MAC Address is displayed 
as configured in Cisco Unified Communications Manager. This information is described in Table 1-4.

Once the extension is selected, the application will initialize using the selected number. The selected 
extension will be used for subsequent sessions from the same PC.

Note Shared Lines are NOT supported as Operator phones. 

Go Unavailable (F10)
You can take a break by going unavailable for a specific time. The calls will still appear on the console 
but you will not be able to answer them. The short cut key for going unavailable is F10. Figure 1-3 
displays the Go Unavailable window that appears when F10 is pressed. 

Figure 1-3 Go Unavailable Window

To become available, click Go Available (F10).

Table 1-4 Duplicate Device Window Fields 

Field Example Description

MAC Address SEP00141C48DDD9 This field specifies the MAC Address. This is the unique 
identifier for a device. If the directory number for a 
device has multiple instances in Cisco Unified 
Communications Manager, the MAC Address is used to 
identify the relevant device.

Directory Number 5351 The number used by the operator to log in.

Description Auto5351 This field provides the description for the device.

Route Partition FACAccess The route partition the extension is configured on.

Calling Search Space FACAccess The calling search space the extension is configured on.
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Interface
Figure 1-4 displays Cisco Unified Attendant Console Advanced interface. 

Figure 1-4 Cisco Unified Attendant Console Advanced Layout 

Key to Figure: 

1. Menu Bar 

2. Queues (F9) 

3. Queued Incoming Calls (F8) 

4. Directories (F3) 

5. Call Control Toolbar 

6. Calls In Progress (F5) 

7. Active Calls (F7) 

8. Parked Calls 

9. Speed Dial (F6) 

10. Status Bar. 

2

7

6

4

5

3

8

9

1

10



1-8
Cisco Unified Attendant Console User Guide

OL-27294-02

Chapter 1      Getting Started
Interface

Menu Bar
Table 1-5 describes the Menu Bar. 

Queues (F9) 
The Queues area displays the queues that are available to logged in operators. An icon is displayed for 
each queue. When an incoming call is delivered to the queue, the number of calls waiting to be answered 
is displayed; a ringing tone is heard by the caller until the call is answered.

In its default configuration, Attendant Console offers all incoming calls to all logged-in operators. 
However, you can configure Cisco Unified Attendant Console Advanced Administration to force calls 
to logged-in attendants in a round-robin fashion. The operators do not need to press the Answer Next 
key for the call to appear in the Active Call area F7. 

Table 1-5 Menu Options 

Control Name Description

File

Login Used to login. 

Log out Log out from Cisco Unified Attendant Console Advanced.

Exit Close the application.

View

Toolbars Activate/deactivate the Call Control tool bar.

Queues Either View All Queues or View Individual Queues.

Speed Dial Activate/deactivate the Speed Dial area.

Call Park Activate/deactivate the Parked Calls area.

Display Salutation Enable/disable the Salutation Window.

Display My Camped on Calls Enable/disable the display of camped on calls. The shortcut for this 
function is (Ctrl-F5).

Options

Preferences Open the preferences window to customize Cisco Unified Attendant 
Console Advanced.

Emergency Set all queues to Emergency Mode. All calls will be forwarded to a 
pre-configured destination.

Filter Searching Activate AND searching.

Font Size Change the font size displayed in the interface. 

Help

Contents Display help.

Keyword Search Use keywords to search the help file.

Graphics Display the icons used within the interface.

About Attendant Console Display Cisco Unified Attendant Console Advanced version and 
copyright.
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Table 1-6 describes the icons that are displayed in the Queues (F9) area of the screen.

Right-clicking a call in the Queues area also provides access to these functions.

Press Ctrl-E to force the queues into Emergency Mode.

Queued Incoming Calls (F8) 
This area displays calls waiting in queues, plus the following information:

• Name of the caller

• Number of the caller

• Elapsed time the call has been waiting in queue

• Name of the queue (optional)

Table 1-7 describes the functions that can be performed on the calls in this area using the keyboard,

These functions can also be accessed through the right-click menu. 

Directories (F3) 
There are two types of directories in Cisco Unified Attendant Console Advanced:

• Full Directory - This shows all of the contacts that are available within the Cisco Unified Attendant 
Console Advanced environment.

Table 1-6 Queues Area Icons 

Icons Types of Queue

Queue that has Forced Delivery configured.

Queue that is active and ready to receive calls.

Queue in night service.

Queue in Emergency mode.

All queues in Emergency mode.

Table 1-7 Function Keys for Queued Incoming Calls Area

Key Function

Plus 
(+) 

Answers the next incoming call.

Note If a queue has Forced Delivery set then this button will not be needed for the call to be 
moved to the Active Calls area F7.

Enter Press to answer the incoming call.
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• Personal Directory Groups - These directories can be modified to display a portion of the Full 
Directory. Personal Directory Groups can be edited, shared, unshared and deleted only by the user 
who created them.

Full Directory

The Cisco Unified Attendant Console Advanced has a directory area where contact information can be 
easily retrieved. The initial directory that is displayed is titled Full Directory, and will display all of the 
contacts that are registered within the Cisco Unified Attendant Console Advanced environment. This can 
include both internal and external contacts.

There are aspects of the directory that are configured through the Cisco Unified Attendant Console 
Advanced Administration, but the basic information that is normally displayed in the columns of the 
table will include contact details such as:

• First Name 

• Last Name 

• Location 

• Department 

• Number 

These are the default settings and can be changed. Figure 1-5 is an example of a Full Directory display.

Figure 1-5 Full Directory 

You can resize the directory columns by dragging their borders, or move columns horizontally by 
dragging them by their header and then dropping them. This also applies to Personal Directory Groups, 
which are described in Personal Directory Groups (F4), page 1-12. 

You can control calls involving contacts in any of the directories in the following ways:

• Use the mouse to select a contact in the directory and then click one of the controls described in Call 
Control Toolbar, page 1-17. 

• Right-click a contact and choose from the menu.

• Use the keyboard shortcuts described in Using the Keyboard, page 1-1. 
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Table 1-8 describes the columns of information displayed for each contact the Directory area. Table 1-9 
describes the functions of the keys used within the Directory area.  

Table 1-8 Directory Area Contact Icons

Column 
Heading Description

 The contact presence status. For details of the icons in this column, see either Viewing 
Microsoft Presence Status, page 3-26 or Viewing Cisco Unified Presence Status, page 3-25, 
as appropriate. 

 The contact phone status; one of the following: 

•  = On hook 

•  = Active 

•  = Unavailable 

•  = Ringing in 

This column also indicates the type of contact number being used:  (mobile),  
(business),  (home),  (fax) or  (pager).

  = The contact has notes attached.

Assistant, Alternate Contacts or additional Contact Numbers. 

•  = The contact has an Assistant added to their Alternate Numbers. This icon takes 
precedence over the Alternate Contacts  and additional Contact Numbers  icons. 
For more information, see Defining Alternate Numbers, page 3-22. 

•  = The contact has one or more Alternate Contacts (but no Assistant) added to their 
Alternate Numbers. This icon takes precedence over the additional Contact Numbers 

 icon. 

•  = The contact has two or more of the following additional Contact Numbers: 

– Mobile 

– Business 1 

– Business 2 

– Home 

– Pager 

– Fax 

This icon does not display if the contact has an Assistant or any Alternate Contacts. 

Table 1-9 Keys Used for Functions within a Directory 

Key Function

Up Arrow Move towards the start of a list. 

Down Arrow Move towards the end of a list. 

Left Arrow Scroll a list left or select the item to the left. 

Right Arrow Scroll a list right or select the item to the right.

Page Down Hold/retrieve the selected call. 
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Personal Directory Groups (F4)

Personal Directory Groups provide the Cisco Unified Attendant Console Advanced operator with the 
ability to create custom directories of specific contacts that are easier to use than the full directory. You 
can create up to 100 Personal Directory Groups, each of which you can share with other operators. For 
details of how to share Personal Directory Groups, see Personal Directory Groups, page 2-10. 

Note The following points: 

• If you have a resilient Cisco Unified Attendant Console Advanced installation, you must be logged 
into the Publisher server to be able to create, delete, edit, share and unshare Personal Directory 
Groups. 

• Each Personal or Full directory contact uses one unit from your contact license. Cisco Unified 
Attendant Console Advanced supports up to 100,000 contacts. 

Enter Call selected number/End active call/Retrieve selected held call.

Tab Move Left-to-Right and Top-to-Bottom through the parts of the Console. 

Shift-Tab Move Right-to-Left and Bottom-to-Top through the parts of the Console. 

F2 Opens Busy Lamp Field (BLF), Presence Status and Alternative Numbers.

F4 Create a Personal Directory Group. 

F12 Open Contact Details. 

Shift-F3 Clear any search results that are displayed in the active directory. 

Note: You can also clear the search results by clicking . 

Shift-F4 Edit an existing Personal Directory Group.

Ctrl-F2 (preference 
specific - See Filter 
Search, page 2-15) 

Open a Lateral Search for alternative colleagues of the selected contact. 
This search will be on the category that has been set within the preferences.

When the Lateral Search window opens, its title bar contains details of the 
directory column searched and the data for the selected contact from that 
column. 

The Lateral Search window can be moved or reshaped as required.

Ctrl-F4 Delete a Personal Directory Group.

Ctrl-Tab and 
Ctrl-Shift-Tab

Either select the next or previous directory tab and display the contact 
details.

Alt-<number>, where 
<number> is a whole 
number in the range 1 to 
10 

Display a specific directory. You can use this method to view the first 10 
directory tabs only. 

Example: If you have five directories and you press Alt-2 the second 
directory tab is displayed, If you press Alt-4 the fourth directory tab is 
displayed.

Table 1-9 Keys Used for Functions within a Directory  (continued)

Key Function
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The user who creates a Personal Directory Group is known as the owner of that group. Only the owner 
of a Personal Directory Group can change, delete, share or unshare the group. Ownership of Personal 
Directory Groups cannot be transferred to other users. The owner of the Personal Directory Group and 
any users sharing it can add, delete and edit manually-added contacts in the group. 

To navigate between Personal Directories, you can either select the tab heading. You can also use 
Ctrl-Tab and Ctrl-Shift-Tab to select the next or previous directory. Alternatively, you can navigate 
directly to any of the first ten tabs by pressing Alt-<number>, where <number> is a whole number in 
the range 1 to 10. 

Creating Personal Directory Groups 

Note You can create up to 100 Personal Directory Groups. 

To create a Personal Directory Group: 

Step 1 Select the directories area, and then either: 

• Press F4 

• Right-click and choose Personal Directory Group > New. 

The New Personal Directory Group dialog box appears (Figure 1-6). 

Figure 1-6 New Personal Directory Group Dialog Box

Step 2 Enter a meaningful Name and Description for the group. 

Step 3 Select a Field on which to filter the contacts. 

Step 4 Select the comparison to make:

• begins with 

• contains 

• ends with 

• is equal to 

• is greater than or equal to (numeric Field data only) 

• is less than or equal to (numeric Field data only)

Step 5 Type a Value to compare the Field data against. 
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For example: Field: Last Name, comparison: begins with, and Value: K, creates a directory of contacts 
whose last name begins with K. 

Step 6 You can click New to add more criteria, up to a maximum of three. Click Remove to remove criteria. 

Step 7 Click OK to create the Personal Directory Group. 

Note The following points:

• If you create a directory using the Field, Number to filter by, the Value you enter is compared 
against all indexed number fields (for example, Main Extension, Business 1, Business 2 and Mobile) 
and all contacts that meet the criteria are displayed. With the directory displaying only the Main 
Extension number or the substitute number (defined in Preferences Tab > General and Internal 
Contacts Number Priority), your Personal Directory Group may appear to contain inconsistent 
results. This indicates that the contact has another numbered field that matches the criteria. 

For example, if a contact has the primary number 22222 and a Business 1 number of 1111, the full 
directory shows 22222. If Business 1 is an indexed field, when you create a Personal Directory 
Group with either Number is equal to 2222 or Number is equal to 1111, the contact is displayed 
with the number 22222. 

• Once you have shared a Personal Directory Group, you cannot change the criteria used to create it. 

Viewing Personal Directory Group Details 

To view the details of a Personal Directory Group, such as the owner and the filter, do the following: 

Step 1 Select the Personal Directory Group. 

Step 2 Do one of the following: 

• Press Shift-F4

• Right-click and select Personal Directory Group > Details 

The Personal Directory Group Details dialog box appears. Click Cancel to close it. 

Modifying Personal Directory Groups 

Only the owner of a Personal Directory Group can modify the criteria used to create it. If you have shared 
a Personal Directory Group, you cannot modify it. 

To modify a Personal Directory Group, do the following:

Step 1 View the Personal Directory Group details. 

Step 2 In the Personal Directory Group Details dialog box, change the criteria as required, and then click OK. 
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Deleting Personal Directory Groups 

Only the owner of a Personal Directory Group can delete it. If you delete a Personal Directory Group it 
no longer exists within the system. If you try to delete a Personal Directory Group to which you have 
manually added contacts, you are given the option of moving them to the full directory rather than 
deleting them. 

To delete a Personal Directory Group, do the following: 

Step 1 Select the Personal Directory Group. 

Step 2 Either:

• Press Ctrl-F4. 

• Right-click and select Personal Directory Group > Delete. 

The Delete Personal Directory Group dialog box appears. The contacts in the Personal Directory 
Group are listed; those with alternate numbers are shown at the top of the list. 

he dialog box asks you to confirm that you want to delete the Personal Directory Group. If the group is 
shared, the dialog box also contains a warning that the group is shared with other users and that it will 
be removed from their screens if you continue. 

Step 3 If your Personal Directory Group does not contain manually-added contacts, continue at Step 5. 

If you have manually-added contacts to the Personal Directory Group that do not exist in any other 
Personal Directory Group, you are warned of this fact, and given the option to move them to the Full 
directory before the Personal Directory Group is deleted. 

Step 4 To delete the Personal Directory Group and all the contacts in it, select Delete contacts. 

To move contacts to the Full directory before deleting the Personal Directory Group: 

a. Select Move contacts to the full directory. 

The manually added contacts are listed. By default, they are all selected for moving to the Full 
directory. 

b. Select each contact you want to move to the Full directory; unselect (clear) any that you do not want 
to move.

Note If you unselect all the contacts, you must either select some contacts to move or select Delete contacts 
before continuing. 

Step 5 Click Yes. 

• If you have not manually added contacts to the Personal Directory Group, it is deleted. 

• If you have not chosen to move any manually-added contacts to the Full directory, the contacts and 
the Personal Directory Group are deleted. 

• If you have chosen to move any manually-added contacts to the Full directory, the contacts are 
moved and the Personal Directory Group is deleted. 

Any users who were sharing the Personal Directory Group see a message telling them that it has been 
deleted; if any were viewing the Personal Directory Group, it disappears from their Console. 
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Note You can also delete a Personal Directory Group from the Personal Directory Group Details dialog box 
that is displayed when you modify a group; click Delete, and then follow the previous procedure from 
Step 3. 

Adding Contacts to Directories 

You can create new contacts in any of the directories displayed: full or personal. Contacts added to the 
full directory are available to all operators. Contacts added to a Personal Directory Group are available 
only to the owner (creator) of the group and any other operators with which the group has been shared. 
The owner of a Personal Directory Group and any users sharing the group can add, delete and edit 
contacts in it; these changes are visible to all users sharing the Personal Directory Group. 

You can select a contact in the Full Directory and drag it to a previously created Personal Directory 
Group tab, regardless of whether it matches the criteria set for that group. Contacts added to Personal 
Directory Groups cannot be dragged to the full directory. 

Note If you have a resilient Cisco Unified Attendant Console Advanced installation, you must be logged into 
the Publisher server to be able to add, delete or change contacts. 

To create a contact in the directory, do the following: 

Step 1 Select the required directory pane by pressing the relevant Alt-<number> combination, or by clicking 
the tab. 

Step 2 Do one of the following, as appropriate: 

• If you are in an active call, press F12. 

• If you are not in an active call, either press Ctrl-T, or right-click within the directory pane and then 
select Add Contact. 

The Contact Details window appears. 

Step 3 Enter the contact details, including the Contact Type: internal contact (the default) or external 
contact. External contacts don’t have any extension details. If the call was active, the contact number is 
automatically inserted into the Contact Numbers tab. If the caller is on an internal number it is inserted 
as the Main Extension number; if the caller is on an external number it is inserted as the Business 1 
number. Enter any other, relevant Contact Numbers, such as the contact’s Home or Mobile numbers. 

Note You cannot change the Contact Type once you have created the contact. 

Step 4 Click OK to save the contact to the selected directory. 

If you were using a Personal Directory Group, only you and any operators you are sharing that Personal 
Directory Group with will be able to use the contact. For more information on sharing Personal Directory 
Groups, see Personal Directory Groups, page 2-10. 
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Deleting Contacts from Directories 

You can remove manually-added contacts from any directory. You cannot delete contacts provided by 
Cisco Unified Communications Manager. 

Note Deleting a contact from a directory permanently removes the contact from the system. 

To delete a contact, do the following:

Step 1 Select the contact, and either press Ctrl-D or right-click and select Delete Contact. 

A confirmation window appears.

Step 2 Click Yes to delete contact from the directory.

Call Control Toolbar 
The Call Control toolbar is located between the Queued Calls and Active Calls areas. It shows icons for 
all the call control operations available at any given time. Figure 1-7 shows an example of the Call 
Control toolbar with a selection of items available and some unavailable. 

Figure 1-7 Call Control Toolbar

Table 1-10 describes the Call Control toolbar icons.

Table 1-10 Call Control Toolbar Icons

Control Name Icon Description

Answer Call Click to answer a ringing call (not a queued call).

Mute Call Click to Mute a Call. This will put the call on hold locally (on the handset) 
and the caller will hear your music on hold.

Clear Call Click to clear an active call. 

Transfer Call Click to complete a pending consultation transfer. 

Retrieve Call Click to retrieve a held call.

Toggle Call Click to switch between Active and Held calls.

Re-establish Click to redo an action previously performed on a call. 
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You can right-click a call in the Active Calls area and choose a menu option to perform these operations. 
You can also access these options using your keyboard (see Chapter 1, “Using the Keyboard”).

Calls In Progress (F5)
The Calls In Progress area displays: 

• Calls that have been placed on hold, which will return on time out 

• Calls that have returned on no reply time out from being either: 

– Parked 

– Transferred to an extension 

The timers for returns are set up through Cisco Unified Attendant Console Advanced Administration.

You can retrieve or re-establish a call from the Calls In Progress area in the following ways:

• Use the mouse to select a contact in the directory and then click one of the tools described in Call 
Control Toolbar, page 1-17. 

• Right-click a call and choose a menu option. 

• Use the keyboard shortcuts described in Using the Keyboard, page 1-1. 

The fields in the Calls In Progress area are described below. 

Hold with Notes Click to attach notes to the current call before placing the call on hold.

Note The notes are for your use, and do not get sent on with the call.

Hold Click to place a specific call directly on hold.

Contact Properties Click to view contact details of the caller. 

Start Conference Click to consult and start conference with another user.

Conference Click to bring the parties together in conference.

Camp on Click to transfer a call to a busy extension.

Park Call Click to place the call on a call parking device.

Table 1-10 Call Control Toolbar Icons

Control Name Icon Description

Field Description

Call For The intended recipient of the call.

Wait Time The caller’s approximate waiting time.

Call From The number from which the call was transferred.
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Active Calls (F7)
The Active Calls area displays calls that are being processed. You can view call information such as:

• Name of the queue

• Current status of the call, that is, Held, Calling, Talking or Busy

Figure 1-8 shows an example of the Active Calls area.

Figure 1-8 Active Calls Area

Note If a queue has been configured to Forced Delivery in Cisco Unified Attendant Console Advanced 
Administration, you do not need to press Plus to answer the call. It will automatically appear in the 
Active Call F7 area and the caller will be in circuit.

Table 1-11 describes the keys that can be used in the Active Calls area,

Status Whether the call has been placed on hold, parked on a busy extension or if the call has 
been returned on time-out displayed as Hold Timeout, Park Timeout, No Reply. 

There are notes attached to the call. Mouse over the call to view the notes. 

Field Description

Table 1-11 Keys Used to Handle Calls in Active Calls Area

Key Function

Up Arrow Move up through the list of calls. 

Down Arrow Move down through the list of calls. 

Enter Answer incoming ringing call/Clear connected call/Complete Consult Transfer. 

Page down Hold/Retrieve the held call.

Insert Camp on call.

Ctrl-F5 Display My Camped on Calls

Plus (+) Answer call with the next highest priority. This is not required if a queue has been 
configured as Forced Delivery. The caller will be immediately connected.

Minus (-) Cancel Consult Transfer.

End Start and join all parties in Conference.

Delete Re-establish a call.

F2 Display Alternative Numbers, Busy Lamp Field (BLF) and Presence Status.
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You can also access these options by right-clicking on a call in the Active Calls area and using the menu.

Parked Calls 
The Parked Calls area displays a list of call park devices (virtual devices where calls can be held 
temporarily and picked from any other call center extension). 

You can hide or display the Parked Calls area by choosing View > Call Park. By default you view all 
devices. 

Table 1-12 describes the controls you can use to control the Parked Calls area. 

The following fields are also displayed: 

• Last call parked at—the number where you parked the last call.

• Parked For—when a call is reverted from a busy extension and you park that call, this field displays 
the name of the contact the call bounced back from

A Call Park device with  Out of Service icon indicates that it is out of service and cannot be used 
for parking calls.

You can park or retrieve the calls in the following ways:

• Using the mouse, select a Call Park device and then click any tool on the Call Control Toolbar, 
page 1-17 

Ctrl-F2 Display the Lateral Search (Cross tab) within the directories. This requires enabling in 
Preferences. 

F12 Contact Details/Add a contact.

Home Park the answered call on a device.

Ctrl-M Send an email to an extension user not responding to a call. 

Ctrl-Q Mute a call when certain actions are taken. This is set up in preferences and the actions 
include Performing a Search, Pressing numeric keys to dial numbers or Changing or 
Selecting Directory screens.

Table 1-11 Keys Used to Handle Calls in Active Calls Area

Key Function

Table 1-12 Parked Calls Controls 

Control Function

Show all Call Park devices.

Show all Call Park devices available to you.

Unused devices are listed with this symbol.

Show only those Call Park devices where you have parked calls.

Devices with calls parked by you are listed with this symbol.

Show only those Call Park devices where other operators have parked their calls. 

Devices with calls parked by others are listed with this symbol.
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• Right-click a device and choose a menu option.

• Use the keyboard shortcuts described in Using the Keyboard, page 1-1. 

Speed Dial (F6)
The Speed Dial area contains a list of your frequently-dialed numbers, enabling you to dial them quickly. 

Figure 1-9 displays an example of a name in the Speed Dials area.

Figure 1-9 Speed Dial Area

You can perform call control operations in the following ways:

• Using the mouse, select a contact and then click any tool described in Call Control Toolbar, 
page 1-17 

• Use the keyboard shortcuts described in Using the Keyboard, page 1-1. 

Note If you have a resilient Cisco Unified Attendant Console Advanced installation, you must be logged into 
the Publisher server to be able to add, delete or change speed dial numbers. 

Adding an entry to the Speed Dial area 

To add a number to the Speed Dial area, perform the following steps:

Step 1 Right-click the Speed Dials area and select Add Speed Dial.

Step 2 Enter Number, Name and Company name of the contact. Figure 1-10 displays the Speed Dial dialog 
box.
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Figure 1-10 Speed Dial Dialog Box

Table 1-13 describes the fields in the Speed Dial dialog box (shown in Figure 1-10).

Step 3 Click OK.

Note You can simply drag and drop a contact from the directories area to the Speed Dial area.

Deleting an entry from the Speed Dial area

To delete an entry from the Speed Dial area, perform the following steps:

Step 1 Select the speed dial you want to delete.

Step 2 Right-click and choose Delete Speed Dial. 

Step 3 Click Yes on the confirmation message. 

Table 1-13 Speed Dial Dialog Box Fields 

Field Example Description

Private Speed Dial Private speed dial numbers can only be edited and viewed by you. 
Other users logging into the application will not be able to view the 
numbers for which this checkbox is selected. If unchecked it will be 
visible to ALL other users.

Number 5550111 Contact number to be saved as speed dial.

Name John Smith Name of the contact.

Company CompanyA Name of the company where your contact works.
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Updating an entry in the Speed Dial area

To update an entry in the speed dial area, perform the following steps:

Step 1 Select the speed dial you want to update.

Step 2 Right-click and choose Edit Speed Dial. 

Step 3 Change the Name, Number and Company as required.

Step 4 Click OK.

Status Bar 
The status bar is an information area at the bottom of the Cisco Unified Attendant Console Advanced 
window; it is divided into sections, each of which shows information about the current state of an aspect 
of the application. From left to right, the sections show: 

• Server Connection. 

• Application Status. For example, Ready.

• Database Connection.

If you hover the pointer over the Server Connection section a message is displayed when you lose your 
connection to the server, or when you are connected to the Subscriber server. For example:

Similarly, if you hover the pointer over the Database Connection section a message is displayed when 
you are connected to the Subscriber database. 

In either case, click the cross or wait 10 seconds to close the message. 

After you have viewed these messages, and for as long as the condition persists, the exclamation mark 
icon remains displayed in the relevant status bar section. 

Frequent Activities 
This section describes the following actions that you will frequently perform using Cisco Unified 
Attendant Console Advanced:

• Dialing a Number 

• Finding Contacts in Directories 

• Lateral Searching (Ctrl-F2), page 1-25 
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Dialing a Number
Instead of selecting a contact from the directories and then making a call, you can dial a number using 
your keyboard. As you type, the digits appear in the Calling box under the Active Calls area. Table 1-14 
lists the available keys that can be used to edit a dialed number. 

The following keys can be used,

Finding Contacts in Directories
Cisco Unified Attendant Console Advanced’s search engine enables you to search for a specific person 
via configured criteria within the directories. This is useful if the console is extremely busy. 

To locate a person or number, perform the following steps:

Step 1 Select the directory that the required contact is in. This could be either the Full Directory, or a Personal 
Directory Group. To navigate between Personal Directories, you can either select the tab heading. You 
can also use Ctrl-Tab and Ctrl-Shift-Tab to select the next or previous directory. Alternatively, you can 
navigate directly to any of the first ten tabs by pressing Alt-<number>, where <number> is a whole 
number in the range 1 to 10.

Step 2 When the Directory Tab is selected the cursor will default to the first search box. Also if you start typing 
the cursor will automatically go to the first search box.

Step 3 You can select any search criteria. You can base your search on any of the following:

• Last Name

• First Name

• Department 

• Number

Step 4 Press the Tab key to jump between the search fields or select the relevant search box using the mouse.

Step 5 Enter a keyword.

Note With AND Searching enabled, either via Options > Preferences > Filter Searching and ticking I want 
to use AND Searching or Options > Filter Searching and tick Use AND Searching it is possible to 
enter keywords in two places. Example being John in the First Name and Smith in the Last Name field. 
The results will display all records that meet the criteria that has been entered in BOTH fields and would 
eliminate records that only meet one of the criteria.

Step 6 Press Enter.

Table 1-14 Lists the keys used to edit the dialed number

Key Function

Backspace Clears digits when typing a contact number

Space Bar Clears the number while dialing out.

Enter Dials the entered number.
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The selected directory will filter out any contacts that do not match the keyword that is entered. For 
example: 

Step 7 Once the required person has been located, either double click or press the Enter key twice to call the 
contact. 

When the call has been completed, the directory search result clears and the full directory is 
re-displayed. You can configure Cisco Unified Attendant Console Advanced so that search results 
continue to be displayed during call control events, such as call answered and call ended. For more 
information, see Filter Search, page 2-15. 

Lateral Searching (Ctrl-F2) 
Lateral Search provides a filter feature that enables you to search specific criteria, such as Department, 
First or Last Names). This feature can be used within any of the contact directories. 

To use the lateral search feature, select a contact from the directory either by using the mouse or 
keyboard. Then initiate a lateral search by pressing Ctrl-F2 which displays an extended search screen 
showing all contacts matching the lateral search area.

The extended search window height can be resized and the window can be moved. After you resize the 
window, the Cisco Unified Attendant Console Advanced memorizes the new size and position of the 
window. 

You can close the extended search window at any time using by pressing the ESC (Escape) key or by 
clicking on the close window icon (x).

When you initiate a Lateral Search, you must complete the selection or close the extended window prior 
to continuing with other features within the Cisco Unified Attendant Console Advanced.

To set the Preferred Lateral Search field, specify the criteria within the Filter Search tab under Options 
> Preferences. Selecting None disables the feature.
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Customizing Cisco Unified Attendant Console 
Advanced

Cisco Unified Attendant Console Advanced provides the ability to customize both the appearance and 
functionality of the application. 

To access the console settings, choose Options > Preferences in the main menu; this will open the 
Preferences window. 

Note You can change the user preferences only when connected to the Publisher server. You cannot change 
them when connected to the Subscriber server. 

The tabs in the Preferences window are explained below. 

General
The following settings are available in this tab: 

• Popup Application When 

Cisco Unified Attendant Console Advanced provides you the options to pop up the application 
when:

– Queued calls are waiting to be answered 

– My local device rings (if this is the device you are logged in with)

– Minimize when not in use 

If either or both of the first two options are checked, the application will pop up on your desktop if 
it is minimized. The third option will minimize the application when there are no calls active or 
queuing.

• Internal Contacts Number Priority 

This list shows the order in which an internal contact’s number type is chosen to populate the 
Number field. If the contact does not have a number of the type at the top of the list, the next number 
type is used, and so-on. 

You can re-order the list by selecting the number type and then moving it with the up arrow and down 
arrow controls.
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• External Contacts Number Priority 

This list shows the order in which an external contact’s number type is chosen to populate the 
Number field. If the contact does not have a number of the type at the top of the list, the next number 
type is used, and so-on. 

You can re-order the list by selecting the number type and then moving it with the up arrow and down 
arrow controls.

Note If you create a directory using the Field, Number to filter by, the Value you enter is compared against 
all indexed number fields (for example, Main Extension, Business 1, Business 2 and Mobile) and all 
contacts that meet the criteria are displayed. With the directory displaying only the Main Extension 
number or the substitute number (defined in Preferences Tab > General and Internal Contacts 
Number Priority), your Personal Directory Group may appear to contain inconsistent results. This 
indicates that the contact has another numbered field that matches the criteria. 

For example, if a contact has the primary number 22222 and a Business 1 number of 1111, the full 
directory shows 22222. If Business 1 is an indexed field, when you create a Personal Directory Group 
with either Number is equal to 2222 or Number is equal to 1111, the contact is displayed with the 
number 22222. 

Figure 2-1 displays the options that can be configured from the General tab. 

Figure 2-1 Preferences Section General Tab
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Display
The Display tab enables you to set the following: 

• Queues Order – if you do not want the queues sorted in the order they were created, check Sort 
queues alphabetically. 

• When a section becomes selected – The Change font Colour setting enables you to change the 
font colors of the labels in Cisco Unified Attendant Console Advanced for the selected area. This 
makes it easy to see which area you have selected when operating the console. The default is that 
the text becomes red. 

• Display Call Information 

– Show Routing Tag enables you to display the name of the queue for each call as well as the 
standard details. This is set by default. 

– Show Time-out Conditions enables you to display details of why a call has returned to the 
operator. 

• When making calls – This controls whether the Busy Lamp Field (BLF)/Presence prompt is 
displayed. By default Prompt if Presence Status is set is not selected. 

• When dragging and dropping – The Display a drag image option enables you to see a complete 
image on screen of the call you are dragging across the screen. 

• Font Size – Use this to change the size of the font in the Cisco Unified Attendant Console Advanced 
interface to help make it easier to use. Select from Default, Medium, Large or Extra Large. You 
can also set this parameter from the main application menu by choosing Options > Font Size. 

• Resilience – Check Prompt when switching servers (the default) to be prompted when servers 
switch during server failure or recovery. 

Figure 2-2 displays the options that can be configured from the Display tab. 
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Figure 2-2 Preferences Section Display Tab
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Presence
This tab provides the Operator with the facility to set the preferences for the Presence information.

• Default Presence Display – Select between either Microsoft Presence Status, Cisco Presence 
Status or None.

• Enable Microsoft Presence Information – To display the Microsoft Presence Information (from 
OCS and Lync) tick this box and select which field will be used to retrieve the information. 

The selection is made via a drop down selection with the choices being: Email, Email 2, Email 3, 
User Field 1, User Field 2, User Field 3 or User Profile. 

• Enable Cisco Presence Information – To display the Cisco Presence Information tick this box and 
select which field will be used to retrieve the information.

The selection is made via a drop down selection with the choices being: Email, Email 2, Email 3, 
User Field 1, User Field 2, User Field 3 or User Profile.

Figure 2-3 displays the options that can be configured from the Presence tab. 

Figure 2-3 Preferences Section Presence Tab 
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Dialling
The following options are available in this tab: 

• Voicemail Prefix –This option enables you to enter a prefix that will send the call directly to an 
extension's voicemail when you right-click a contact and select Transfer to Voicemail. 

• Auto Dial – This option enables you to automatically dial an internal or external number after a 
defined time. You can set the duration of time for Auto Dial. The desired number is entered in the 
area below Active Calls.

Figure 2-4 displays the options that can be configured from the Dialling tab. 

Figure 2-4 Preferences Section Dialling Tab

Call Transfers
The following options are available in this tab: 

• When Dragging and Dropping or Double Clicking 

This section enables you to choose the type of transfer you would like to perform when dragging 
and dropping or double clicking a call. You can click a radio button to choose one of the following 
options:

– Perform consultation transfer 

– Perform blind transfer (this is selected by default) 

• When Blind Transferring 

When Blind Transferring a call, you can select Automatically Campon if busy. This automatically 
stacks the call on to the extension until it becomes available and increases the speed of call handling.

• When Re-establishing a Call 

When re-establishing a call, you can select Automatically Campon if busy. This automatically 
stacks the call on to the extension until it becomes available and increases the speed of call handling.

Figure 2-5 displays the options that can be configured from the Call Transfers tab. 
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Figure 2-5 Preferences Section Call Transfer Tab 

Call Park
This tab provides a checkbox. If you check the checkbox, after a call has been parked, all park devices 
will be displayed in the Call Park area.

Figure 2-6 displays the options that can be configured from the Call Park tab. 

Figure 2-6 Preferences Section Call Park Tab

Mute
This section enables the user to enable automatic muting of calls. The User can select any of the 
following options:

• Performing a search – Selecting this checkbox will automatically mute a call when the operator 
clicks in any of the search fields.

• Pressing numeric keys to dial numbers – Selecting this checkbox will automatically mute a call 
when the operator dials a number.

• Changing or selecting Directory screens – If the user selects this checkbox, a call will be 
automatically muted if the operator clicks on the directories.

When one of these options is selected the call will be held locally (on the handset) and the caller will 
hear music on hold. 

Figure 2-7 displays the options that can be configured from the Mute tab. 
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Figure 2-7 Preference Section Mute Tab.

Tones
This section enables for Tones to be switched on or off depending on specific events happening. The 
Tones are then made by the attendant console when the events occur.

The following options are available in this tab:

• When I have made myself unavailable – This option has a checkbox Do not play any tones. Select 
this to prevent the application from playing a tone while you are temporarily absent from the 
Console Attendant.

• When a queued call is waiting to be answered – This option has a checkbox Play a Ring Tone. 
Select this to play a tone while a call is waiting in a Queue.

• When a call has timed out – This option has a checkbox Play a Ring Tone. Select this to play a 
tone when a call reverts from the Calls In Progress area or Call Parking area.

Figure 2-8 displays the options that can be configured from the Tones tab. 

Figure 2-8 Preferences Section Tones Tab
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Directory 
The Directory tab enables you to configure and influence the way that contact information is displayed 
within the Directory area of the Cisco Unified Attendant Console Advanced. It has the following 
sections:

• Directory Groups - This is where you can influence how a specific directory will be displayed. This 
can be done collectively by ticking the box next to All directory groups use the same settings, and 
then selecting a directory from which all others adopt their parameters. If several directories are 
visible, changing the position or width of a column in one immediately changes the others in the 
same way.

Alternatively, if All directory groups use the same settings is not ticked, you can select a directory 
from the table and then configure the selected directory independently of the others.

From this list you can also alter the order in which the directories will be displayed. This is done by 
selecting a Directory and using the Up and Down arrows to move it within the list.

Note The creation or editing of the directory content is actually done within the Directory area of the Cisco 
Unified Attendant Console Advanced.

• Default Display Order – The data in this contact record field is used to sort the contacts when they 
are displayed in the directory. Select from Department, First Name, Job Title, Last Name (the 
default), Location, Number and User Field 1. 

Note If you change the Default Display Order the changes will not appear on your screen until you log out 
of Cisco Unified Attendant Console Advanced and then log back in. 

• Show the following information – Select the contact data fields to display in the directory. The 
order the fields are listed is the order in which they are displayed. To change the display order, select 
each relevant field, and then use the up arrow and down arrow keys to change its position in the list. 

• Search Based On – Choose how many and which search fields to use to search for a record in the 
Internal Directory. Use Display this many search fields on the screen to display up to six fields. 

Figure 2-9 displays the options that can be configured from the Internal Directory tab. 
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Figure 2-9 Preferences Section Directory Tab 

Personal Directory Groups 
The Personal Directory Groups tab enables you to share Personal Directory Groups with other operators 
in your community. For more information about Personal Directory Groups, see Personal Directory 
Groups (F4), page 1-12. 

The Personal Directory Groups tab is available only when the following are true: 

• You have created at least one Personal Directory Group. 

• If you have a resilient Cisco Unified Attendant Console Advanced installation, you must be logged 
in on the Publisher server. The tab is not visible when logged in on the Subscriber server. 
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• There is at least one other operator in the same community to share the Personal Directory Group 
with. 

Figure 2-10 Preferences Section Personal Directory Group Tab 

The tab displays lists of: 

• Personal Directory Groups that can be shared 

• Operators with which Personal Directory Groups can be shared 

To share a Personal Directory Group, do the following:

Step 1 Select it from the upper list.

Step 2 In the lower list, select the check boxes corresponding to the users you wish to share it with. If required, 
use the controls to select or unselect (clear) the check boxes of all users. 

Note To cease sharing a Personal Directory Group with a user, clear the check box next to their name. 

Step 3 Click OK or Apply (clicking OK closes the tab). 

A message appears on any other live consoles to tell their attendants when a Personal Directory Group 
has been shared or unshared. 
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Alternate Numbers 
Use the Alternate Numbers tab to define how to display any alternative numbers information that a 
contact may have. The tab is shown in Figure 2-11. 

Figure 2-11 Preferences Section Alternative Numbers Tab

The Show the following information setting enables you to specify what information is displayed for a 
contact. Click the check boxes to select the information. Use the up/down arrows to specify the order in 
which the information is displayed. 

Alternate Numbers Display Order – use the up/down arrows to specify the order in which the 
information is displayed. Set this to the same order used in the Directory area. 

Field Headers
You can change the text of Field Headers that appear in the application by simply entering new Display 
Text to replace the Default Text. 

To change the Display Text for Field Headers, perform the following steps:

Step 1 Select the text in the Display Text column. Initially, this is the same as the Default Text. 

Step 2 Type new Display Text.
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Step 3 Click OK.

To restore default text, click the Restore Defaults button.

Figure 2-12 displays the options that can be configured from the Field Headers tab. 

Figure 2-12 Preferences Section Field Headers Tab 
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Secondary Sort

Note This tab is enabled only when you are logged out from Cisco Unified Attendant Console Advanced: you 
cannot change the secondary sort parameters when you are logged in. 

You can customize the way Cisco Unified Attendant Console Advanced sorts and searches the data by 
specifying a Secondary Sort Column (by default, this is set to First Name). You can restore defaults if 
required. The Restore Default button enables when a value is changed from the Secondary Sort 
Column. 

To change the values in Secondary Sort Column, perform the following steps:

Step 1 Click on a value in the Secondary Sort Column.

Step 2 A drop down menu will appear with different values related to the values in the Sort Column.

Step 3 Choose a value to replace the previous one.

Step 4 To change more than one value, repeat steps 1-3.

Step 5 Click OK.

Figure 2-13 displays the options that can be configured from the Secondary Sort tab. 

Figure 2-13 Example Preferences Section Secondary Sort Tab
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Filter Search
As you search in any of the search fields within the directories, you can specify how you want the search 
to perform on screen. This tab enables you to set those preferences by selecting the following options: 

• During call control 

Select Retain existing directory search to retain the search results during call control events. If you 
do not select this, call control events (such as call answered, new call directly to operator's 
extension, and call ended) clear the search results and re-display the full directory. When you select 
this you have to press Shift + F3 to clear the search results. 

• AND Searching 

This enables the Attendant to select two criteria at once and search for entries that meet both of 
them. Example being John in the First Name and Smith in the Last Name field. The results will 
display all records that meet the criteria that has been entered in BOTH fields and would eliminate 
records that only meet one of the criteria.

Tick the box I want to use AND Searching to enable this function.

Note This feature can also be activated from the Option menu, Filter Searching and ticking Use AND 
Searching

• When Performing a Filter Search 

– Press Enter to perform search – Once you have entered some information in any one of the 
search fields, selecting this option would perform a search when you press the Enter key.

– Search after every key press – This option refreshes the search results with every key you press 
to enter a search value in the field. This is the default setting. This option is disabled if you select 
I want to use AND Searching. 

– Search after a delay – If this option is selected and you enter information in the search field, 
the search result will be displayed with a delay in seconds specified using the Search Delay 
slider. 

• Lateral Search 

The Lateral Search feature enables you to search for an alternative contact by pressing Ctrl-F2. 
Select from None, First Name, Last Name, User Field 1, Job Title, Location, Department or 
Number. Selecting None disables Lateral Searching. 

Figure 2-14 displays the options that can be configured from the Filter Search tab. 
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Figure 2-14 Preferences Section Filter Search Tab 

Logging
This tab enables you to turn logging on and off. Use the checkboxes to control the following logging:

• Database: To enable logging of database activities within the console application.

• Server Communication: To enable logging of server communication activities within the console 
application.

The log path and file name appears. 

Figure 2-15 displays the options that can be configured from the Logging tab. 
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Figure 2-15 Preferences Section Logging Tab

Advanced 
The Advanced tab controls which types of directly transferred calls (according to their destination) are 
sent back to the operator if unanswered. 

Note If you use Direct Transfers you will lose recall functionality, and the only calls the system will be able 
to recall internally are ones to devices monitored by the Cisco Unified Attendant Console Advanced 
Server. 

Direct transfers allow the end party to see the originating CLI (Caller Line Identification – the caller's 
number). However, using Direct Transfers restricts the Console's ability to return transferred calls to the 
operator if they are not answered.

By default, blind transfers redirect calls from the operator's handset to the Service Queue (CTI Port), and 
the call is then connected to the end party. By contrast, Direct Transfers bypass the Service Queue and 
send the call directly to the end party. The caller is not placed on hold (so they hear ringing rather than 
music), and the originating CLI is displayed to the end party, rather than the details of the Service Queue.

Figure 2-16 displays the settings that can be configured from the Advanced tab. 

Figure 2-16 Preference Section Advanced Tab 
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This section describes bow to use Cisco Unified Attendant Console Advanced to do the following:

• Answering Calls, page 3-2

• Transferring Calls, page 3-7

• Making Calls, page 3-11

• Placing Calls on Hold, page 3-12

• Retrieving Held Calls, page 3-13

• Muting Calls, page 3-13

• Call Parking, page 3-13

• Retrieving Parked Calls, page 3-14

• Conferencing Calls, page 3-15

• Re-establishing Calls, page 3-15

• Toggling Calls, page 3-16

• Controlling Reverted Calls, page 3-16 

• Supplying FACs and CMCs, page 3-17 

• Clearing Calls, page 3-18 

• Using Emergency Mode, page 3-18 

• Sending Emails, page 3-19 

• Viewing Call Status, page 3-19 

• Viewing and Using Contact Details, page 3-21

• Viewing Cisco Unified Presence Status, page 3-25

• Viewing Microsoft Presence Status, page 3-26
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Answering Calls
Cisco Unified Attendant Console Advanced attends two types of calls,

• Internal Calls – that are received from a local extension

• External Calls – that are received from an external number

Calls that are being attended appear in the Active Call area (F7). Figure 1-8 on page 1-19 shows an 
example of a call in the Active Calls area. 

The calls coming into the system are prioritized and queued in the Queued Calls area (F8). Calls can be 
answered using the following three methods,

• Answer Next – Answering the next call in queue.

• Cherry Picking – Selecting a particular call from the queue to answer.

• Forced Delivery - Queues can be configured as Forced Delivery which means the calls will be 
distributed to the longest idle Attendant.

Answer Next
Incoming calls are prioritized by the system and then displayed in the Queued Calls area (F8) in 
descending order of priority.

Use Answer Next to answer queued calls in the order of priority set by the system. 

To answer the next call using the keyboard, perform the following steps:

Step 1 Press F8 to select the Queued Calls area.

Step 2 Press the Plus (+) key

The next highest priority call is delivered to your handset.

To answer the next call using the mouse, perform the following steps:

Step 1 Right-click in the Queued Calls area.

Step 2 From the menu, choose Answer Next.

Irrespective of the call you right-clicked, the next highest priority call is delivered to your handset. 

Cherry Picking 
The incoming calls being displayed can be cherry picked from a specific queue as required.

In order to answer a call you must select a queue and then select the call you wish to answer.

To select a queue using the keyboard, perform the following steps:

Step 1 Press F9 to select the Queues area. 

Step 2 Use the up and down arrow keys to select the required queue. 
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Step 3 The F8 area will display the calls that are waiting in the selected queue.

Note To revert back to seeing all calls from all Queues, select All Queues icon from F9.

If you are using a mouse, simply click on a queue in the Queues area (F9). After selecting the queue, 
you are ready to take waiting calls. 

To answer calls in the selected queues, using the keyboard, perform the following steps:

Step 1 Select the Queued Calls area by pressing the F8 key. 

Step 2 Using the up and down arrow keys, select the call to answer.

Step 3 Press Enter key to connect the call.

To answer calls in the selected queue using a mouse, perform the following steps:

Step 1 Select the All Queues area.

Step 2 Click on the relevant call.

Step 3 Click the  Answer Call button in the call control tool bar.

A personal call direct to your extension will show in the Active Calls area, and ring your handset. You 
can answer by picking up the handset, or by clicking the  Answer Call button.

Note You can simply drag and drop a call from the Queued Calls area (F8) to the Active Calls area to answer.

Forced Delivery
A specific queue can be designated to be immediately answered by the next free Attendant. The calls in 
this queue are configured to be presented to the longest idle Attendant or a circular work-share between 
Attendants logged in and able to answer the queue. The Answer Next key (Plus) is not required as the 
call will go directly to the Active Calls area and ring the handset. You can answer by picking up the 
handset, or by clicking the  Answer Call button. 

Operators can log out while a forced delivery call is ringing on their handset. 
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Directory Call Forwarding
If a contact has Call Forwarding set on their device then an icon will reflect this in the Directory area. 

Note In an instance where a contact has multiple lines the Call Forwarding icon will only be displayed if it is 
configured on the primary line. 

Hovering over the contact will display a tool tip providing further details, such as the number that the 
Call Forwarding is set to divert to. For example: 

To see any secondary lines, press F2, which displays the Presence Status window. 



3-5
Cisco Unified Attendant Console User Guide

OL-27294-02

Chapter 3      Using Cisco Unified Attendant Console Advanced
Answering Calls

Alternate Numbers and Presence Status 
To display the Alternate Numbers and Presence Status for a contact, select the contact and press F2. The 
Alternate Numbers For <contact> - [<presence>] window appears. For example: 

The Alternate Numbers window is also displayed if you transfer a call to an extension with a presence 
status assigned. 

Click the controls on the left of the window to display a pane containing relevant information. All the 
panes contain the following: 

• Alternate Contact Details—this lists any alternative numbers for the contact. If the number is saved 
in the directory, the contact's full name is displayed instead of the number. 

• Call controls—use these to control a call to an alternate number; for example, to place it on hold. 
For more information, see Controlling Calls, page 3-6. 
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The specific contents of each pane are listed below: 

The Phone Status icons are shown in Table 3-2. 

Controlling Calls 

To control a call, do the following:

Step 1 Select a contact from Alternate Contact Details.

Step 2 Click the required call control icon:

• Answer Call

• Call 

• Consult 

• Blind Transfer 

• Transfer to Voicemail 

• Hold 

• Hold with Notes 

Table 3-1 Alternate Numbers Panes 

Pane Displays

Summary Contact Phone Status, Cisco Presence, and Microsoft Presence. 

Phone Status Contact Phone Status, including the status of any multiple lines linked to the 
phone. 

Cisco Presence Cisco Presence. If Cisco Presence is not configured, status Unknown is 
displayed. 

Microsoft Presence Microsoft Presence and Notes. If Microsoft Presence is not configured, status 
Unknown is displayed.

Table 3-2 Phone Status Icons 

Icon Description

On-hook 

Off-hook 

Unavailable 

Ringing in

Ringing out

Ringing out on busy extension

Connected

Call on hold

Call forwarding 

Notes
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• Start Conference 

• Park Call 

Alternatively, click Close to cancel. 

Table 3-3 list the keyboard shortcuts that you can use:

Transferring Calls
After answering the call, you can transfer it to a requested device, contact or external number. A transfer 
can be made either as a blind or consult (announced) transfer. Calls can be transferred to any available 
destination either internally or externally.

Transferring a call is straightforward using the mouse or the keyboard and can be completed by either 
entering the desired extension number (if known), or searching the directories for the correct contact.

A blind transfer is a call that is transferred without consulting the recipient.

Blind Transferring to a Known Number
To blind transfer a call to a known number using the keyboard, perform the following steps:

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 Type the destination number (internal or external). The cursor is automatically placed in the Dial Box. 

Step 3 Press Enter twice in quick succession to transfer the call.

To blind transfer a call to a known number using a mouse, perform the following steps:

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 Using the keyboard type the destination number (internal or external). The cursor will automatically be 
placed in the Dial Box.

Step 3 Press Enter. This will initiate the transfer.

Table 3-3 Keystrokes for Controlling a Call

Key Description

Enter The call is consult transferred to the selected alternative number.

Enter + Enter (press Enter twice) The call is blind transferred to the selected alternative number.

Ctrl-P Park and Page dialog box opens for the call for the selected 
alternate contact. This only applies if paging is running, the 
selected contact is internal, and paging is supported by the selected 
alternate phone.
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Step 4 Press  Transfer again to transfer the call.

Blind Transferring to a Directory Contact
If the extension number of the desired recipient is not known you can easily search the Directory to find 
the correct contact. The directories will allow searches to be made via a number of search fields that 
appear at the top of the Directory area.

To blind transfer a call to a Directory Contact using the keyboard, perform the following steps:

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 If searching for a contact using the first displayed search field, simply start typing. Alternatively pressing 
F3 will take the cursor to the first displayed search field. The cursor will automatically move to the first 
search field. If you need to use a search field that isn’t the first on the screen, use the Tab key to find the 
right field to type into.

Step 3 As you type, the directory will shrink as contacts are matched (Depending on how Filter Search is 
configured; for more information, see Filter Search, page 2-15). Keep typing until the required contact 
is found, or use the up or down arrow to highlight the contact.

Step 4 Double-click the Enter key to transfer the call.

To blind transfer a call to a Directory Contact using the mouse, perform the following steps:

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 Click into the required search field in the Directory area. Alternatively, pressing F3 will take you to the 
first search field in the displayed directory

Step 3 Start typing and as you type the directory will shrink as contacts are matched. Keep typing until the 
required contact is visible and use the mouse to select the desired contact

Step 4 Double-click the contact to initiate the transfer.

Step 5 Press  Transfer to transfer the call.

Or 

Step 1 Point the mouse at the relevant call within the Active Calls area.

Step 2 Press the left mouse button. 

Step 3 Whilst holding the mouse button down, drag the call to the relevant destination within the Directory 
area, and then release mouse button. 

Note In an instance where the contact is in a specific Personal Directory Group, you can open that directory 
by hovering the mouse over the Personal Directory Group tab, to open it before selecting the contact.

Or 

Step 1 Select call details that are displayed in the Active Calls area. 



3-9
Cisco Unified Attendant Console User Guide

OL-27294-02

Chapter 3      Using Cisco Unified Attendant Console Advanced
Transferring Calls

Step 2 Point the mouse at the relevant destination within the Directory or Speed Dial areas and click the right 
mouse button to reveal a Popup menu. 

Step 3 From the popup menu choose Call.

Step 4 Ensure that the call initiated is selected within the Active Calls area. 

Step 5 Click the Complete Transfer button.

If a transferred call is not answered within a certain time duration, the call is reverted back to the Active 
Calls area. These calls can then be handled through Reverted Call Controls explained in Controlling 
Reverted Calls, page 3-16. 

Initiating a Consult Transfer
In this case, the destination of the transfer is consulted before the actual transfer takes place.

Consult Transferring to a Known Number

To consult transfer a call to a known number using the keyboard, perform the following steps:

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 Type the destination number. The cursor is automatically placed in the Dial Box.

Step 3 Press the Enter key to make the enquiry call.

Step 4 After consulting with the destination press the Enter key to complete the transfer.

To consult transfer a call to a known number using a mouse, perform the following steps:

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 Using the keyboard type the destination number. The cursor will automatically be placed in the Dial Box.

Step 3 Press the Enter key. This will initiate the transfer.

Step 4 Press  Transfer again to transfer the call after consulting.

Consult Transferring to a Directory Contact

If the extension number of the desired recipient is not known, you can easily search the Directory to find 
the correct contact. The directories will allow searches to be made via a number of search fields that 
appear at the top of the Directory area.

To consult transfer a call to a Directory Contact using the keyboard,

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 Select the Directory that the contact appears in. This can be done by pressing Alt and the Number of the 
tab. Example: Alt and 3 will open the 3rd tab, Alt and 5 will open the 5th tab.
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Step 3 If searching for a contact using the first displayed search field, simply start typing. The cursor will 
automatically move to the first search field. Alternatively, pressing F3 will also move the cursor to the 
first search field. If you need to use a search field that isn’t the first on the screen, use the Tab key to 
find the right field to type into.

Step 4 As you type the directory will shrink as contacts are matched (Depending on how Filter Search is 
configured; for more information, see Filter Search, page 2-15). Keep typing until the required contact 
is found, or use the up or down arrow to highlight the contact.

Step 5 Press the Enter key to initiate the enquiry call.

Step 6 After the consult, press the Enter key again to complete the transfer.

To consult transfer a call to a Directory Contact using the mouse, perform the following steps:

Step 1 Answer a call or select the call in the Active Calls area.

Step 2 Click into the required search field in the required Directory. In the case where Personal Directories have 
been created, click on the respective Directory tab.

Step 3 Start typing and as you type the directory will shrink as contacts are matched (Depending on how Filter 
Search is configured, See Filter Search, page 2-15). Keep typing until the required contact is visible and 
use the mouse to select the desired contact. 

Step 4 Double-click the contact to initiate the transfer.

Step 5 Press  Transfer to transfer the call after consulting.

Or

Step 1 Point the mouse at the relevant call within the Active Calls area.

Step 2 Press the left mouse button. 

Step 3 Whilst holding the mouse button down, drag the call to the relevant destination within the required 
Directory by hovering over the Directory tab, and then selecting the contact before releasing the mouse 
button. This sets up the enquiry call.

Step 4 Press  Transfer to transfer the call after consulting.

Or

Step 1 Select call details that are displayed in the Active Calls area. 

Step 2 Point the mouse at the relevant destination within the required Directory or Speed Dial areas and click 
the right mouse button to reveal a Popup menu. 

Step 3 From the popup menu choose Call.

Step 4 Ensure that the call initiated is selected within the Active Calls area. 

Step 5 Click the Complete Transfer button.

Although in these procedures a consult, or enquiry call has been made, if for some reason the transferred 
call is not connected within a certain time duration, the call is reverted back to the Active Calls area. 
These calls can then be handled through Reverted Call Controls explained in Controlling Reverted 
Calls, page 3-16.
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Making Calls
Cisco Unified Attendant Console Advanced enables you to dial and make calls. Calls can either be made 
directly to a contact or can be made using different call controls such as Call Parking, Transferring and 
Conference. These call controls are explained in detail, see Appendix 1, “Call Control Toolbar Icons”. 
There are two types of call that can be made: 

• Internal Call – Calls that are made to the numbers existing within the system. For example, in a call 
center, calls made to the numbers within the call center are called internal numbers.

• External Call – Calls that are made to the numbers external to the system. For example, an operator 
in a call center can make a call to a customer for marketing purposes.

Making Internal Calls 
To call a local extension, perform the following steps:

Step 1 Enter the required number. No matter which area of the console you have selected, as you type, the digits 
will appear in the Calling box under the Active Calls area.

Step 2 Press Connect/Clear with the mouse or Enter key using the keyboard.

A call will be initiated for the selected contact and the details will be displayed in the Active Calls area.

Making External Calls
To make an external call using a keyboard, perform the following steps:

Step 1 Dial the number of the access code and then the external number. (Unless Cisco Unified Attendant 
Console Advanced is configured to add the Access Number. This is done on the Cisco Unified Attendant 
Console Advanced). 

Step 2 Press Enter key to start dialing.

It is not necessary to place the cursor in the Calling Box, when you start typing the numerical values, it 
will automatically type in it.

To make an external call using a mouse, perform the following steps:

Step 1 Select the required Directory using the mouse. 

Step 2 Double click on the number to dial.
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Placing Calls on Hold
While answering a call, Cisco Unified Attendant Console Advanced can place the active call on hold to 
answer other incoming calls. The call is held on a Service Queue for the time period set as Hold Recall 
Time in Cisco Unified Attendant Console Advanced Administration. After the Hold Recall Time 
elapses, the status of the call will change from Held to Hold Timeout. These calls can be handled 
through Reverted Call Controls explained in Controlling Reverted Calls, page 3-16. A call can be 
reverted irrespective of whether the Timeout has been reached. Figure 3-1 shows an example of a call on 
hold in the Calls In Progress area. 

Figure 3-1 Call On Hold in the Calls In Progress Area

The call will be shown in the Calls In Progress area and retrieved to the Active Calls area at any time. 

To hold a call through the keyboard, perform the following steps:

Step 1 Press F7 to select Active Calls area.

Step 2 Select a call using up and down arrow keys. 

Step 3 Press the (Page down) key to hold the selected call.

To hold a call using a mouse, perform the following steps:

Step 1 Select a call in Active Calls area.

Step 2 Click the  Hold button.
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Retrieving Held Calls
Calls placed on hold can be retrieved from the Calls In Progress area to Active Calls area. Calls reverted 
from Hold, Park and Transfer can also be seen in Calls In Progress area. 

To retrieve a held call using keyboard, perform the following steps:

Step 1 Press F5 to select Calls In Progress area.

Step 2 Select a call using up and down arrow keys.

Step 3 Press the (Page down) key to retrieve the held call.

To retrieve the held call using mouse, perform the following steps:

Step 1 Click on a held call in the Calls In Progress area.

Step 2 Click the  Retrieve button.

Muting Calls
Cisco Unified Attendant Console Advanced provides the ability to mute a call when certain actions are 
being undertaken. There are two types of Mute, the first is automated and is set via the Options > 
Preferences > Mute tab. If this has been enabled it can include when a search is being made, when a 
number is being dialed, or if you are changing or selecting Directory screens.

The second type of muting a call is manual and is instigated either by pressing the Mute button ( ) 
or pressing Ctrl-Q. The same key combination will also un-mute a call. Alternatively you can right-click 
on the active call and select Mute from the menu.

Call Parking
Cisco Unified Attendant Console Advanced provides you with the ability to park calls on to a call 
parking device. A parked call can be picked up from any phone on the Cisco Unified Communications 
Manager by simply dialing the extension number at which the call is parked. You can either park a call 
on a specific Park Device, or let the system select the device for you. You can see the available Call 
Parking devices in the Call Park area. 

To park a call using a keyboard, perform the following steps:

Step 1 Press F7 to select Active Calls area.

Step 2 Select a call using up and down arrow keys.

Step 3 Press the Home key to park the call on one of the available call parking devices.

To park call using a mouse, perform the following steps:

Step 1 Select a call in the Active Calls area.
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Step 2 Click the  Park Call button.

To Park a call on a specific device using the mouse, perform the following steps:

Step 1 Select the call in the Active Calls area

Step 2 Drag the call to the desired Park device and drop the call by releasing the mouse button.

If a parked call is not answered within a certain time duration, the call is reverted back to the Calls In 
Progress area. Such calls can then be handled through Reverted Call Controls explained in Controlling 
Reverted Calls, page 3-16.

Retrieving Parked Calls
To retrieve a parked call using a mouse, in the Call Parking Device where the call is parked, do one of 
the following: 

• Double-click the device 

• Drag and drop the call to the Active Calls (F7) pane 

• Right-click the device and select Retrieve from the menu 

• Click the  Retrieve button.

To retrieve a parked call using the keyboard, perform the following steps:

Step 1 Dial the Park device number.

Step 2 Alternatively, if a parked call remains unanswered for a certain period of time (known as Call Park 
Recall), it will revert back to the Calls In Progress area, from where the Cisco Unified Attendant 
Console Advanced can retrieve the call using methods stated in Retrieving Held Calls section.
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Conferencing Calls
A Conference call enables you to add a third person to a call session.

With a connected call, to start conference with a third party using a mouse, perform the following steps:

Step 1 Select the extension that is to be added into the conference or type the number.

Step 2 Press the Start Conference button and the conference is initiated.

Step 3 Wait for the third party to answer and press the  Conference button.

With a connected call, to start conference with a third party using the keyboard, perform the following 
steps:

Step 1 Select the extension that is to be added into the conference or type the number.

Step 2 Press the End key. 

Step 3 Wait for the third party to answer and press the End key to join all three parties.

Once the conference is in progress an additional field is highlighted in the Active Calls area. The field 
is labeled as Conference Controller and is used to drop you out from the call once all the parties are in 
conversation. Figure 1-8 on page 1-19 shows an example of a conference call in the Active Calls area.

If any of the parties does not respond to the conference call, the call is reverted back. Such calls can then 
be handled through Reverted Call Controls explained in Controlling Reverted Calls, page 3-16.

Note If the third person does not want to start the conference, Cisco Unified Attendant Console Advanced 
clears the initiated call. This will take you back to the original call.

Re-establishing Calls
This feature is a time saver. The re-establishing of calls means to repeat the previous process in a single 
click. From the F5 and F7 areas you can re-establish the calls to undo the previous action as in the 
following areas:

• Hold Call

• Transfer Call

• Conference Call

• Park Call

If due to some reason the process does not succeed, you can click the Re-establish button to repeat it. 
If you are using a keyboard, press Delete to re-establish.



3-16
Cisco Unified Attendant Console User Guide

OL-27294-02

Chapter 3      Using Cisco Unified Attendant Console Advanced
Toggling Calls

Toggling Calls
With two active calls in progress, one held and one connected, you can toggle between them.

When a contact is called for consultation, the incoming call is put on hold. Once the destination accepts 
answers, you can right-click on the incoming call in the Active Calls area and choose Toggle. The 
incoming call that was held during consultation will become active. 

On the other hand, the call made to the external contact will be put on hold. You can also toggle using 
the keyboard using the Plus (+) key.

Controlling Reverted Calls 
If a call cannot be put through to an extension, it will be returned to the Calls In Progress area (F5). This 
may be because the contact could not answer the call in time. Cisco Unified Attendant Console 
Advanced provides a set of call controls specifically configured to handle reverted calls without having 
to search for the recipient again.

Once the call hits the Active Calls area after being recalled from the Calls In Progress area, you can 
view the Reverted Call Controls by simply right-clicking on the call.

These call controls are similar to the ones explained previously. The only difference is that in case of 
reverted calls, all the call controls are in context to the contact the call was initially transferred to.

If you right-click on the retrieved call and choose Start Conference, the contact on the extension from 
where the call was reverted will be added to the conference automatically. You would not need to search 
through the directory or specify the extension for that particular contact. 

Table 3-4 summarizes what you can do to a retrieved call.

Table 3-4 Call Controls Used on Reverted Calls 

Control Name Icon Description

Clear Call Click to clear an answered call. 

Consult Click to consult and transfer the answered call to the 
extension from where the call was initially reverted.

Blind Transfer Click to transfer the answered call to the extension from 
where the call was initially reverted.

Re-establish Click to redo an action previously performed on the reverted 
call. 

Hold with Notes Click to attach notes to the current call before placing the 
call on hold.

Hold Click to place the reverted call directly on hold for the same 
extension/contact the call was reverted from, without taking 
notes for the contact. 

Contact Properties Click to add or update details of the contact from which the 
call was reverted. 

Start Conference Click to consult and start conference with the contact the 
call was reverted from.
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Right-clicking on a call in the Active Calls area and choosing an option from the menu can also perform 
the above-mentioned operations. You can also access these options using your keyboard, as described in 
Using the Keyboard, page 1-1.

Supplying FACs and CMCs 
You may need to provide a Forced Authorization Code (FAC) and/or Client Matter Code (CMC) to 
perform an External Blind Transfer. The Administrator configures these codes through Cisco Unified 
Attendant Console Advanced Administration. If this is required during a consultation transfer you will 
see a dialog box on screen, simply enter the correct code and your call will be made.

Forced Authorization Code (FAC)
Forced Authorization Codes are used to provide security in Cisco Unified Communications Manager for 
dialing Route Patterns. Traditionally, this is used to block calls to external or international numbers. 
For example, often in call centers, only some agents are allowed to make external consult transfers to 
certain numbers. In order to enforce security, these callers are provided with a Forced Authorization 
Code. The concept of FAC is that if you make such an external call transfer that is protected by a FAC, 
you must enter the FAC before the call can continue. If an incorrect FAC is entered, or if no FAC is 
entered, the call fails. Figure 3-2 displays the FAC Dialog box.

Figure 3-2 FAC Dialog Box

Camp on Click to transfer a call to a busy Operator.

Park Call Click to place the call on a Call Parking Device.

Table 3-4 Call Controls Used on Reverted Calls  (continued)

Control Name Icon Description
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Client Matter Code (CMC)
Client Matter Codes are used to provide extra call logging facilities within Cisco Unified 
Communications Manager. This is used to log calls for different clients.

The concept of the CMC is that you must enter CMC Code before an external call or transfer can 
proceed. The call detail records are updated with the CMC code along with the call information. This 
can then be used later on to charge calls to different cost centers.

Clearing Calls
In order to disconnect an active call when the enquiry is complete, you need to clear the call from the 
Active Calls area.

To clear a call using the keyboard, perform the following steps:

Step 1 Press F7 to select the Active Calls area.

Step 2 Press Enter.

To clear a call using a mouse, perform the following steps:

Step 1 Click on a relevant call within the Active Calls area.

Step 2 Right-click and select Clear Call.

Using Emergency Mode 
Cisco Unified Attendant Console Advanced enables you to set Emergency Mode for all the queues. 
When the queues are in Emergency Mode, all calls are automatically redirected to another destination, 
Night Service or Voicemail for example. These destinations are configured by the Cisco Unified 
Attendant Console Advanced.

To put a queue in Emergency Mode using the mouse, perform the following steps:

Step 1 From the main menu, choose Options > Emergency.

Step 2 Move the Available Queues to the Emergency Queues list using the  button to move all Queues, 
or the  button to select Queues from the list. 

Step 3 In the Set Emergency Mode message box, click Yes to move all the queues to Emergency Mode.

Step 4 Press OK to complete the process.

You can also use the keyboard shortcut to switch to Emergency Mode. Select the Queue area and press 
Ctrl-E. The following window appears. Click OK to continue. Figure 3-3 displays an example of the 
Emergency Mode screen with a Queue placed in Emergency Mode.
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Figure 3-3 Queues in Emergency Mode

To take queues out of Emergency Mode, perform the following steps:

Step 1 Right-click on a queue and select Emergency.

Step 2 Click OK to complete the process.

Sending Emails 
When you forward a call to an extension and it is returned on time out, you have the option to send an 
email to the person to provide important information about the call. The shortcut key for sending email 
is Ctrl-M. Alternatively you can select a contact with a Right mouse click and from the Contact sub 
menu there is an option to Send Email.

Note There has to be an email address in the Contact Details for the Cisco Unified Attendant Console 
Advanced to be able to function.

Viewing Call Status
Call Status is what is currently happening to the call: ringing, held, connected or busy. 

You can view the call status of any device in the directory. The Status window enables you to view the 
status of a contact before transferring a call or connecting a conference call to them. 

To view device status, perform the following steps:

Step 1 In the Directory, right-click a contact, and then choose Contact > Status > Calls. 
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The Call Status of the selected contact appears. For example: 

The Calls columns are described in Table 3-5. 

You can also answer any ringing call by clicking the  Answer button. 

Table 3-5 Call Status Window Fields 

Field Example Description

Name John Smith Name of the contact

CLI 2000 This is the number call was made from

DDI 1001 This is the number call was made to

Status Talking The current status of the call
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Viewing and Using Contact Details 
Each directory contact has relevant information associated with it, some of which is displayed in the 
directory area. To see more information for a specific contact, select it and then do one of the following:

• Click  (Contact Properties). 

• Right-click and then choose Contact > Contact Details. 

• Press F12. 

The Contact Details window appears. For example: 

Figure 3-4 Contact Details Window 

You can edit any of the information in the Contact Details window, except for fields with grayed labels. 
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Emailing Contacts 
If the email address of the contact person is added in the Contact Details, then Cisco Unified Attendant 
Console Advanced can mail the contact from this window. It will open the mail client configured on your 
machine. You can click the  to write an email. 

Dialing External Numbers 
Click the Contact Numbers tab to view the contact’s external phone numbers. All the direct numbers 
defined for a contact are displayed. 

Select a number and then click Use Number to dial that number. 

Figure 3-5 Contact Numbers Tab 

Defining Alternate Numbers 
You can define alternative numbers for a contact:

• A single Assistant. 

• Any number of Alternate contacts. 

To add an alternate number, do the following:

Step 1 Click the Alternate Numbers tab. 

Step 2 Under either Assistant or Alternate, as appropriate, click Add.

The Select dialog box appears

Step 3 Select the contact and then click Add. 
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Step 4 In Contact Details, click OK. 

Controls enable you to Delete Alternate Numbers, or Replace each with another. 

Editing Contact Details 
To edit contact details do the following: 

Step 1 Select the required directory pane by pressing the relevant Alt-<number> combination, or by clicking 
the tab. 

Step 2 Select a contact. 

Step 3 Do one of the following:

– Press F12 

– Right-click and then choose Contact > Contact Details. 

– Click  (Contact Properties)

The Contact Details window appears.

Step 4 Edit the contact information as required. 

Step 5 Click OK. 

Adding Absent Message and Contact Information
You can add Absent Messages and General Contact Information through the Notes tab. Absent 
messages are short notes explaining why the extension is not manned or not to be disturbed.

• Contact Information - Add extra information to any of the contacts in the directories. This 
information will be displayed with the contact as tool tip. 

• Absent Message - Add an absent message with any of the devices in Directory area. 

Note This information is displayed with the contact as tool tip.
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Figure 3-6 Contact Details Notes Tab 
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Viewing Cisco Unified Presence Status
Attendants can view CUP (Cisco Unified Presence) information for IP Phone users in the directory area. 
This information shows the contact’s availability. Figure 3-7 shows an example. 

Figure 3-7 CUP Information

The presence status icons are listed below. 

To view Presence Status as text, hover the mouse cursor over the presence status icon. Any additional 
information entered by the contact is also displayed; for example, their vacation return date. 

Icon Status Description

Away Presence status away\be right back.

Busy Presence status busy.

DND Presence status Do Not Disturb (DND).

Offline Presence status offline.

Online Presence status online (available).

Unknown Presence status unknown.

Derived Presence status busy.
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Viewing Microsoft Presence Status 
Cisco Unified Attendant Console Advanced can display Microsoft Presence Information for contacts 
that have been added to the local copy of Microsoft Office Communicator.

Where contact status has been set, the following presence status icons will be displayed in the Directory 
area.

To view Presence Status, perform the following steps:

Step 1 Select a contact in a Directory.

Step 2 Hover over a presence status graphic.

Step 3 Presence Status details will be displayed

There is also facility to hover over the contact icon with the mouse and a pop up display will provide any 
additional information that might be available for the status (ie in the case of Vacation it will display a 
return date). 

Icon Status Description

Away Presence status away\be right back.

Busy Presence status busy.

Do Not Disturb Presence status no not disturb (Reachability status of Do Not Disturb)

Inactive Presence Status Inactive. This is automatically triggered by Communicator 
if the account is inactive for a defined period. Default is 5 minutes. 

Busy Inactive Presence Status Busy Inactive. This is automatically triggered by 
Communicator if the account has gone from Busy to inactive for a defined 
period. Default is 5 minutes. 

Offline Presence status offline 

Online Presence status online (Reachability status of Available)

Unknown Presence status unknown (Reachability status of Unknown)
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